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 装置使用の前に 
以下のルールを守って下さい 
• 研究室内は土足厳禁、飲食厳禁です。ゴミはきちんと片づける 
• 装置の故障、不具合を見つけたらすぐにスタッフに連絡 
• 装置を乱暴に扱わない 
• 研究室の物を勝手に持ち出したり、無くしたりしない 

• 貴重品の管理は各自でお願いします。長時間部屋から抜ける場
合などは、研究室の施錠も各自で行う事 

• ステージの移動操作時、各装置のステージ位置稼働制限を守り
ましょう。動かし過ぎると試料が検出器にぶつかり、故障します 

• ソフトウェア、ハードウェア上のパラメータなどを変更した場合、
装置使用後に必ず設定を元に戻す 

• 分析装置PCに直接自分のUSBなど記録メディアを差し込まない。
当研究室専用のUSBを利用し、解析用PCを経由してデータを取り
出す事 

• 分析室内に導入するものは全て素手で触らない。備品を利用し
て汚した場合は自分で洗浄する事 

• 使用者が予約を取って、予約時間通り使用して下さい。予約時
間からずれ込む場合は予約を事前に変更して下さい 

• 深夜早朝祝休日に使用する場合、使用中のトラブルは全て貴研
究室の責任で対応。また、装置利用について自分の指導教官に
知らせておく事。緊急連絡先は研究室入口ドアの横に記載して
あります 

• 初めて使う方は事前にスタッフに連絡を取って、講習を受けて下
さい 

• ガスの出やすい試料、大きすぎる試料、壊れやすい試料など、
分析室真空度を劣化させる試料を勝手に入れない。心配な試料
は事前にスタッフにご連絡下さい 

 
 

2 



3 

 装置使用の前に 

 使用記録簿に名前や時間等を
記入。使用前の分析室真空度を
チェックして値を記入する 

 使用後の分析室真空度のチェックと終了
時間の記入を忘れないで下さい。予約時間
とずれ込む場合は必ず先に予約を変更して
下さい 

 Ar+イオンガンのイオン化室

真空度と分析室真空度をチェッ
クして下さい。通常は 
 イオン化室 ~10−4𝑃𝑎 
 分析室   ~10−7𝑃𝑎 

著しく真空度が劣化している場
合はスタッフに連絡 

イオン化室 

分析室 

 イオンガンユニットで
Channel/float voltageボタンを押し

て点灯させ、ディスプレイに表示さ
れた番号が「７」である事を確認し
て下さい 

 イオンガンの電流電圧条件が各Channelに
入力されており、Channel番号を呼び出す事

でイオンガンが各条件に設定されます。
Channel「7」はイオンガンが使えない設定に
なっています 

イオンガンユニット 
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 試料の準備 

 装置の立ち上げの前に試料をホ
ルダーにセットします。ホルダー類
は真空デシケーターの中に保管さ
れています。通常の試料であれば
ノーマルホルダーを利用 

大型試料(100mmφ以下)も専用ホルダーがあ

ります。利用についてスタッフにご相談下さい。
またガスが出やすい試料や高さがある試料
などについてもご相談下さい 

 

 留め金やカーボンテープなどを
使い、試料をホルダーに固定。試
料が完全に固定されているのを確
認して下さい 

 粉末試料はペレット状に加工するか、カー
ボンテープや金属薄膜に付着させてブロアー
で十分に粉を飛ばすなどの処理を行って下さ
い。少しでも試料が分析室内に残ると他の
ユーザーの分析に半永久的に影響します 

ノーマルホル
ダー(予備) 

ノーマル
ホルダー 

帯電試料用
ホルダー 

帯電試料用ホ
ルダーの蓋 

大型ホルダー 

留め金&ネジ ホルダー固定台 

少し高さがある試料は底部を外し
て固定します 

出来れば留め金固定は両脇に。固定後
はホルダーを振るなどしてみて固定を確
認して下さい。X線源と留め金&試料の位
置関係に注意して下さい 
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 試料の準備 

・帯電試料用ホルダーについて 

 中和電子銃を使った帯電補正を、試
料にバイアス電圧をかける事でより効
果的にします 

試料下部に+100V印加し、GNDの蓋部と電位差を

つける事で中和電子を効率的に試料表面に当てる
事が出来ます。帯電緩和の他、Ar+イオンガンでの

エッチング時に、エッチングによる表面電位のズレ
を抑制する効果があります 

  

 左絵のように試料を搭載し蓋をして
固定します。試料の厚みは1.3mmが限

度です。蓋部とホルダーの金属部が接
着しないようにセットします。試料表面
が蓋部より出ないようにします 

 固定後にホルダーの蓋部と端子部の
間で導通が取れていない事を確認しま
す 

導通があると蓋部に電圧をかけられないので効果
がありません 

・試料の表面汚染について 

 空気中での表面汚染を出来るだけ防ぎたい場合、ドライプロセスで作成した試料については
作成後すぐにアルミホイルで包んだり、真空装置に保管して大気に晒さないで下さい。ウェットプ
ロセスで作成した試料についてはアセトン洗浄した後に純粋洗浄、すぐにエアーダスターなどで
十分ブローし、アルミホイルなどで包んでください 

・試料のリファレンスピークについて 

 試料のチャージシフトの補正やケミカルシフトの確認の為にリファレンスとなるピークを試料に用
意しておくと、解析の際良いと思います(リファレンスとなるピークがないなら)。炭素試料はチャージ
シフトの補正にコンタミ成分のC1sピークを利用出来ない場合があるのでなおさら。Au薄膜やAuメッ
シュを一緒に乗っけて測定したり、試料にAuをコートしておいて一緒に測定するとか、粉末体ならば
他の化学状態が分かっている粉末を混ぜ込んだりして一緒に測定すると良いでしょう 
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 試料準備室への導入 

 ホルダーを試料準備室に導入して真
空を引きます。始めに準備室のロックを
外し、VENTボタンを押して準備室を大気
に戻します 

 準備室中のレールに平行にホルダー
を載せ、奥側と接着。ホルダー裏の穴が
開いてある方が奥側です 

 試料導入棒の黒いリングを回して
「OPEN」から「CLOSE」に変えます。リング

を回すとレールの下のフックが上下動し
ます。ホルダー下側から覗き込んでホル
ダーの穴にフックがはまっているのを確
認する事 

 ホルダーがセット出来たら扉を閉めて
ロックをかけ、VENTボタンをもう一度押し
て真空に引き直す 

ここで失敗してると分析室に導入出来ません。必ずホ
ルダーがちゃんとセット出来てるか確認して下さい 
 

 

1 

2 

VENTボタン 

  
どっち回しでも可 

目視確認 

準備室真空計 

 分析室への導入は準
備室で真空を十分に引
いてから行います。真空
を引く間に装置の立ち
上げを行います 

金属板1枚なら20分くらい。粉
末だと1試料約1時間はかか
ります 

まだまだ引きます 
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 装置の立ち上げ 

 始めに冷却器の電源を入れます。温度表
示が出れば問題ありません。次にSPECボタ
ンとX-Rボタンを押して、点灯させます 

 冷却器の電源が必ず先です。消す時は必ず後です 
 X-Rボタンを押すともう一つの奥の冷却器が起動します
(音が聞こえます)。二つの冷却器でX線源を冷やしてます
のでこれらはX線放射中は稼働してなければなりません 

SPECボタン 

X-Rボタン 

 ステージランプ、カメラ電源、カメラモニ
ター、測定用PC、PCモニターの電源を入
れます。PC立ち上げ後、デスクトップの
「SpecSurf(Acquisition)」をクリックしてXPS
ソフトウェアを立ち上げます 

ステージランプ 
カメラ電源 

カメラモニター 

カメラ本体は↑です 
触れないで下さい 

解析用ソフト 

旧ソフト 

 Acquireメニューか
らXPSを選択して左

下のウィンドウが出
れば問題ありません
(出なければ再起動) 

冷却器 
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 装置の立ち上げ 

 X線の立ち上げを行います。始
めにX線源の種類を決めます 
• Mg-Kα線 
• Aｌ-Kα線 
• モノクロX線(Al) 
 Mgの場合はAl/Mgボタンを点
灯、Al の場合は消灯させます。
モノクロX線の場合はAlを選び、
MONO/STDボタンを押して点灯さ
せます 

 線源選択後、FILAMENTの電源を
ON、ADJつまみをゆっくり回して
CURRENT表示で３Aまで電流を上げ
ます。上げてから5分待ちます 

 分析室真空度を確認して真空度が急激に劣
化しないように回して下さい。急ぐとガスが大
量に出て放電します 

 次にディスプレイの表示をX-RAY 
POWERに切り替えて、X-RAYの電
源をONにします。3kV,5mAが印加
されます。電圧・電流のつまみを3
分ごとに1刻みずつ順番に回し、
10ｋV,10mAまで上げていきます 

モノクロX線の場合は12ｋV,25mAまで 

 最後にAnalyzerの電源をONにします 
 よく忘れるので注意 

アナライザー電源 

モノクロX線の場合 
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 分析室への導入 

 ステージの位置を試料交換位
置に移動させます。ステージコン
トローラーのP/Mボタンを押して
表示をMEMORYに切り替え、メ
モリーNo.をUP,DOWNボタンで操
作し、No.SEを呼び出します。
MOVEボタンを押すと表示された
位置にステージが移動します 

 基本すでに試料交換位置にいるので動
きませんが必ず確認して下さい 

 準備室の真空を十分に引いた状態
でV1ボタンを押してバルブ解放。導

入棒の黒いリングを手前に押して試
料を分析室に導入します。のぞき窓
からホルダーとステージを確認しな
がら入れて下さい。奥まで入れたらリ
ングを回して「OPEN」にし、黒いリン

グを後ろまで一番引き抜き、もう一度
V1を押してバルブを閉めます 

 少しでも違和感があったら無理に
入れず、スタッフを呼んで下さい 

完全に0に
一致させる 

1 

2 

3 

ホルダーの溝にステージ
がはまります 

一番奥で止まります リングを回してすっと
引き抜いて下さい 

ステージコントローラー 
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 分析室への導入 

  
 V1バルブが閉まったら分析室真空度
を確認します。真空度が5.0 × 10−6Pa

より劣化してる場合、試料を直ちに試料
準備室に回収し、準備室で真空引きを
続けて下さい。再度導入し、 5.0 ×
10−6Paより良ければ、分析室で真空度
が落ち着くまでしばらく待ちます 

10.0× 10−7Pa以下ぐらいまで真空度を下げましょう 

 
 測定位置へジョイスティックを使い、
ホルダーを移動させます。測定中心点
はカメラモニターに表示される十字で
す。試料が複数ある場合、位置をメモ
リーする機能を使うと連続測定が出来
て便利です。P/MボタンでMEMORYに
切り替え、UP,DOWNボタンでメモリー
したいNo.を呼び出し、ENTボタンを押
すと現在位置がメモリーされます 

 測定位置を合わせる時は
必ずZ軸も合わせてください。

カメラをズームさせて十字の
センターでカメラフォーカス
が合うようなZ値を探します 

 ずれてると分析位置が合いませ
ん。強度も出ません。エッチングの
位置もずれます 
 モノクロX線測定の場合は「モノク
ロX線の設定」のところでZ位置合わ
せを行います 

カメラズーム 

カメラ本体に触れない 

ジョイスティック 
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 装置の立ち上げ(続き) 
 X線源の電圧電流を上げ終わった
ら、SpecSurfのXPS Acquisitionから
Sourceタブを選択し、X線源の種類、
電圧電流値を入力後、Statusで
「On」をクリック(「Off」がついてたら
先に「Off」をクリック) 

 Automatic Offにチェックをつけて設定すると
測定終了時やDepth profileのエッチング中な
どにX線を自動でOffに出来ます 

 StatusがUpdateに替わったら、X
線源ユニットのAUTO/MANUボタ
ンを押してAUTOに切り替えます 

 以降、X線源の設定を変更したい場合は
AUTOからMANUに戻して下さい 

測定範囲 角度絞り 視野絞り 

3.0mmφ 36 36 

1.0mmφ 34 14 

0.2mmφ 12 9 

0.03mmφ 7 0 

 測定範囲の設定は左画の2つ

の絞りで切り替えます。ロックネ
ジを緩めて、測定範囲を狭める
場合はCLOSE方向、広げる場合
はOPEN方向に絞りを回して左表
の数値に合わせます。36は
OPEN方向に一周分開いて0に合
わせます 

 回し過ぎに注意して下さい。間違った方
向に回さないで下さい 
 Depth profileなど、エッチング前後の様
子を見比べる場合は1mmφにした方が良
いです(3×3mmの範囲が削れますが、ま
ともに削れている範囲は1mmφ程です) 
 ミクロ測定(0.2mm、0.03mm)を行う場合

はカメラの十字が正しい分析位置を指定
出来ているか検証出来るものを用意し、
検証した方がいいです 

ロックネジ 
CLOSE 

OPEN 
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 モノクロX線の設定(利用時) 

  

 モノクロX線を利用する場合、「装
置の立ち上げ」でモノクロX線を立

ち上げ終わった後、他に行う事が３
つあります 
 
• 分光結晶の窓を開ける 

 本体中央にある左画の切替器で、
bakingからmonochromeを矢印に
合わせる 

ロックネジを緩めてから回して下さい 
 

• X線源の位置を引かせる 

 本体後ろにある左画のツマミを時
計回りに回して、X線源を適当なと
ころまで後退させる 

測定後、必ず元の位置に戻して下さい 

 
• RatemeterでZ軸の調整 
 ステージTiltを-10°まで傾かせ、

目的試料を分析位置に移動。
Acquire→RatemeterでRatemeter
ウィンドウを立ち上げ、Centreに測

定元素のメインピーク値を入力し、
Start。ピークの強度がMaxになる
ステージZ軸の値を見つけ、その位
置で測定作業orステージのメモ
リーに記憶させる 

 RatemeterのPass、Dwell、Refresh timeなど
の値はZ移動によるピーク強度の増減が見や
すいよう適宜変更して下さい 
 XPS acquisitionウィンドウを閉じないと
Ratemeterウィンドウは出てきません 
 

 

ロックネジ 

X線源位置
目盛り 

 後ろ側にある
ので誤って他の
パーツに触れな
いよう注意 

切替器 

Ratemeterウィンドウ 
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 Ar+エッチングの設定(利用時) 

 試料表面のコンタミネーションを削りたい場合、または深さ方向
のプロファイルを取る場合にAr+イオンガンの設定をします 
 モニターの十字を中心に3×3mmの範囲でエッチング出来ます 

 Ar+イオンガンエッチングは表面の化学状態に影響を与える場合があり、エッチングを行
いながら化学状態分析をする場合、エッチングによる影響について検証した方が良いです 

 試料導入後、分析室真空度が
10.0× 10−7Pa以下になるまで待ちます 

 真空度が悪い状態で以下の工程を行わないで下
さい。放電して装置が落ちます 

 イオン化室の真空計でAVCボ
タンを押します。左画のArガス
バルブをゆっくり開きます。6時

を指すマーカーから反時計回
りにおよそ一回転させます。イ
オン化室ガス圧が上がります 

奥のバルブ
を回す 

 Arガスバルブを微調整し、9.5X10-2Paぐ
らいで落ち着くようにします 

  12.5 × 10−2Paを超えるとエラーになります。開け過
ぎないように 
  分析室の真空度も下がります。2.0 × 10−5Paより劣

化した場合はエッチングを中止してバルブを閉めてくだ
さい 

 オートバルブコントローラーの
電源をONにします。バルブが

閉められ始め、イオン化室真空
計の値が一旦下がります 

オートバルブコントローラー 

Arガスバルブ 

イオン化室真空計 
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 Ar+エッチングの設定(利用時) 

 Channelボタンを押してXつま

みを回し、エッチングの条件を
選びます。条件は下表の通り
です。Etching rateはSiO2で測
定したものです。Ch4はモノクロ
X線測定の時にCh1と同じ条件
でエッチング出来る仕様です 

channel Ch1 Ch2 Ch3 Ch4 

Beam energy 3000eV 2000eV 1000eV 3000eV 

Emis current 20mA 20mA 20mA 20mA 

Etching rate 10.0.nm/min 5.6nm/min 1.5nm/min 12.0nm/min 

 XPS AcquisitionのExperimentタブから
Experimentを「Depth Profile」に切り替え
後、Profilingタブを選択します。Presetに
使用するchannel番号、Pressureに「8.5」
と入力し、Setをクリック。次第にガスバ
ルブが緩み、ガス圧が8.5X10-2Pa付近で
落ち着けばAr+エッチングの準備は終了 

(Depth profileの場合はここまでやる) 

 Irradiation ON/OFFボタンで

エッチングを開始出来ます。
Timer DisplayをONにするとエッ

チング経過時間がディスプレイ
に表示されます(Timer Resetを
押すと時間がリセットされます) 

2015/7/24
更新 



15 

 中和電子銃の設定(利用時) 

 導電性のない試料の場合、
光電子の放出によって試料表
面に不均一な帯電が発生して
しまう事があります。結果とし
てエネルギー値や半値幅に
影響を与えます 

 中和電子銃により、試料表
面に電子を供給する事で帯電
現象を緩和出来ます 

中和銃未使用 中和銃使用 

ガラスサンプル 

・中和電子銃利用方法 

1. 中和電子銃ユニットの電
源をON 

2. SELボタンを押してADJUST
の項目をFIL.に切り替え、
ADJつまみを回し、適当な
電流値まで上げる 

3. メニューのAcquireから
Ratemeterを起動させる 

  次ページに続きます 

XPS Acquisition

を開いてる場合
は先に閉じる 



16 

 中和電子銃の設定(利用時) 
4. Centreに強度の高いピーク

のエネルギー値を入力。
Pass、Dwell、Refresh timeは

ピーク形状が見やすくなる
ように適当な値に適宜変更 

5. Startボタンを押し、各検出
器のCount数を確認 

6. Acc.VをON。SELボタンで
ADJUSTをAcc.Vに変更後、
ADJつまみを回して電圧値

を変化させながら、
RatemeterでピークCount数

が一番大きくなる電圧値を
探す 

7. 電圧値が見つかったらその
値で固定、Ratemeterを閉じ
て通常通りの測定を行う 

ピークCount数だけでなく、ピーク位置、ピーク半値
幅も正常な値になるような電圧値を見つける 
試料ごとに適当な電圧値を見つける 

・帯電試料用ホルダーを使っている場合 

 上記の電子銃設定を行う前に左図の
電源を起動させてホルダーに電圧を印
加させます 
1. POWER ON 
2. OUTPUT ON 
3. CURRENTを微量流す 
4. VOLTAGEを100.0Vに設定 

  
直流電源装置 
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 Wide scan 

 測定法は全部で6種類あります。

どの測定を行う場合でもまずは
Wide scanで測定しておくと良いで
しょう 
ExperimentでWide scanを選択 

 現在のステージ位置で測定する場合は
MovementでNoneを選択、ステージコン

トローラーのメモリー機能を使う場合は
Memoryを選択 
 Lens Modeに設定した測定範囲を選択 

 Stageタブで連続測定するメモリー番号の
始めの番号(First)と終わりの番号(Last)を入
力(Memory選択時) 
 RegionsタブでWide scanの各条件を設定 

 Pass(eV)はエネルギー分解能と強度に関わります。値を

小さくすれば分解能が上がり、強度が下がります。大体
5eV程が限界です。Step(eV)間隔はPass(eV)の1/100程に
設定すると良いです。Scansは測定してみて調整します。
ピークに対し、定性ならばバックグラウンドノイズの3倍、
定量ならば10倍は強度が取れるように設定します。Scan
回数のルートでバックグラウンドノイズは減少します(主に
Narrow scan時に設定) 

 Startボタンで測定開始し
ます。Checkボタンを押す

と測定予測時間が表示さ
れます 
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 Markerの付け方 

  
 Wide scanを取ったらマーカーをつけ

てピークの同定をします。左画のアイ
コンをクリック 

 スペクトル上にラインが現れます。ピー
クにドラッグして当てるとSuggested Peaks

に想定される元素一覧が表示されます。
Elementから元素を選択してAddを押すと

元素名がスタンプされます。元素によっ
てはChemical Shiftの一覧も載っており、
これもスタンプ出来ます。最後にOKをク
リックするとスタンプが残ります 

Displayのチェックボックスで表示を各種変更出来ます 
 

 XPSハンドブックアイコンで標準試料

のスペクトルを見る事が出来るので参
考にして下さい 

 スペクトルにはピークではないものが良く映り込
みます。間違って同定してしまわないように気をつ
けて下さい。サテライトピーク、オージェピーク、ス
ピン軌道相互作用による分裂など 
 Mg-Kαだと730eV高いとこにO-Kα由来のスペクト
ルが、230eV低いとこにAl-Kα由来のスペクトル
(ゴーストピーク)が重なる事があります 
 近くに置いた別試料のピークが映る事もあります 
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 Narrow scan 
 Wide scan後、定量や化学状態分析の

為、分解能の高いモードで各元素のメイ
ンピーク付近のスペクトルを取得します。
ExperimentでNarrow scanを選択します 

 Movement, Lens Modeは「Wide scan」を参照 
 Sourceタブは変更がなければそのままで 

 Stageタブでメモリー番号をセットしま
す(Memory使用時、「Wide scan」参照)。

試料によって測定内容が違う場合はこ
こで試料のグループ化を行えます。
Groupsにグループ名を入力後Addをク
リック。First, Lastに1組の番号を入力し、
Groupから名前を選択します 

 Comment欄に情報を入れとくと便利です。 
 左画はメモリーNo.1がCrグループ、No.3がPETグ
ループと登録され、1と3だけスキャンを行います 

 RegionsタブでGroupを選択し
(Group登録時)、測定する元素を
Elementから選択します 
 Wide scanスペクトルを開き、

左画のアイコンをクリックすると、
スペクトル上にStartライン(緑)と
Finishライン(赤)が表示されます。

ピークに合わせてライン位置を
調整すると、測定範囲の条件に
反映されます 

全てのWide scanで確認しましょう 

 残りの項目も適当に設定
します(特にScan回数、
「Wide scan参照」) 
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 Narrow scan 

 測定中、経過をAcquisition Statusで
確認出来ます。Pauseを押すとscan1巡

後に測定が中断され、左画のように
Scans回数だけ変更出来るようになりま
す。変更後Continueをクリックすると測
定が再開されます 

Stopを押すとscan1巡後で測定終了になります
Abortは強制終了 

・スペクトルウィンドウについて 

 カーソルをスペクトル上にやる
とウィンドウ右下にエネルギー
位置と強度が表示されます 

 一度の測定で得たスペクトル
は一つのウィンドウに格納され
ています。各sample、各Region、
各Levelはウィンドウ右上のメ
ニューから表示を変更出来ます 

 データのSave, Openなどもウィンドウ単
位になります 
 Memory番号、出力したデータの表記
番号が1番からに対し、sample番号が0
番から付けられます 
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 Depth Profile 
 Depth ProfileではAr+エッチングと

測定を交互に繰り返す事によって、
試料の深さ方向のプロファイルを取
得出来ます 
 
 ExperimentでDepth Profileを選択

し、イオンガンのガス圧調整を行う
(「Ar+エッチングの調整」を参照) 
 Acquisition ModeでFullを選択 

 Separate(PB別法)とSimultaneous(PB同時法)
を選択するとPeakとBackgroundのエネルギー

位置を指定してその差分強度だけを取得しま
す。スペクトルを取得しない分高速で測定が出
来ます。元素のピーク強度プロファイルだけ取
れればいい場合に使えます(「Image & 
Linescan」参照) 
 

 Profilingタブでエッチング時間の
設定を行います 

 左画では1回目(levelという単位)の測定前に0
秒、2回目~4回目の測定前に各15秒、5回目
~10回目の測定前に各60秒ずつエッチングを
行うようになっています 
 

 あとの設定は「Narrow scan」と同
様です。補足として、 

・ガス圧の設定を行ってからガス圧が上がるの
を待って測定を始める 
・SourceタブではStatusでAutomatic OFFを推奨 

・アトミックミキシング、選択スパッタリング等を
考慮した解析が必要な場合があります 
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 Angle Resolved 

 Angle ResolvedではステージのTilt

をアナライザー軸に対して徐々に傾
けながらスペクトルを取得して、非破
壊で試料の深さ方向のプロファイル
を取得出来ます 

 高傾度測定をしたい場合の以下の
設定をします 

 最大80°まで傾けられるので平均分析深さ
6nmから1nmぐらいまでのプロファイルを取得出
来ます 
 高傾度にする事で測定する表面の領域がY方

向に伸び、信号量を増やす事も出来ます。微小
量分析に向いてます 

 ステージを大きく動かす分析なので十分に気
を付けて下さい。事前にスタッフにご相談下さい 

 分析後は必ずハード・ソフト共に設定を元に戻
して下さい 

 このモードで測定する際はステージのメモリー
に位置を登録しないで下さい 
 

 ・XPS本体での設定 

 試料を分析室に導入。傾ける
ので必ずホルダーに試料をしっ
かり固定する 

 磁場レンズステージのマイク
ロメーターを回し、Z=18.45から
Z=7.25付近まで下げる。下部に

あるスイッチが押されるのを確
認する(小さくカチッと音がしま

す。マイクロメーターの回しが硬
くなる。回し過ぎると壊れます) 
  

磁場レンズステージ 

磁場レンズ 

スイッチ 

マイクロメーター 
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 Angle Resolved 

・Spec Surfでの設定 
 View→ConfigurationからSystem 
Configurationダイアログを立ち上
げて、Sample HolderでHigh Angle
を選択します 
 Tiltを-30°から80°まで動かせる

ようになります。以降、十分に注意
してステージ操作して下さい 

 高傾度測定の場合は後はWide&Narrowの
分析をするだけ 

 
 ExperimentタブでAngle Resolved
を選択し、Profilingタブでステージ

の傾ける角度の設定を行います。
左画の設定だと0°から80°まで
5°ずつ傾けながら各レベルのス

ペクトルを取得します。マイナス側
へは１０°以上傾けるのは禁止 
 残りの設定は「Wide Scan」、
「Narrow Scan」を参照 
 ホルダーがX線源にぶつかりそう
な場合はX線源の位置を引く 
(「モノクロX線の設定」参照) 

 
  

 ←マイナス方向に傾け
るとX線源にぶつかる恐

れがあるので、基本禁止
です。スタッフにご相談
下さい 
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 Total Reflection 
 Total ReflectionではモノクロX線を使
用し、X線の全反射が起こるようス

テージの位置関係を調整する事で通
常の測定深さから約2/3浅く、またS/N

比良くスペクトルを取得出来ます。主
に試料表面の汚染物質の評価に利
用出来ます 

 平滑な表面を持つ試料(Siウェハーなど)でなけ
れば測定出来ません 

・Total Reflection測定方法 

1. 試料表面がステージと平行になる
ようホルダーに設置、試料導入 

2. モノクロX線を立ち上げ、Ratemeter

で試料の光電子スペクトルを確認
しながらZ位置を調整します(「モノク
ロX線の設定」参照) 

3. EｘperimentでTotal Reflectionを選
び、Tiltを-10°から-5°まで0.2°

ずつ傾けて適当にスペクトルを取
得、S/N比の傾向を確認 

4. -4°から‐1°まで1°ずつ
Ratemeterでスペクトルを確認しな
がら、強度が出るよう再度Zの調整
(追い込み)をします 

5. Zの調整が終われば-1°でスペクト
ル測定を行います 

 試料やホルダーが少し傾いていると-1°で測定
出来ません。S/N比が良い適当な傾きをRatemeter
で見つけて測定を行って下さい 
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 青：通常測定 赤：全反射X線測定 
 BackgroundでGainを合わせると、コン
タミネーションのCのピーク強度が2倍
ほど大きくなっているのが分かる 
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 Si2p 
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 工程3を飛ばしてもそんなに問題あ
りません 
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 Image & Linescan 
 Imageでは最大5.0×1.8cmの元

素マッピング像を取得出来ます。
ケミカルシフトを利用して化学状態
の違う元素のマッピングも可能 

 まず事前に取りたい元素の
Narrow scanを取得しておきます 
 ExperimentでImageを選択し、
Acquisition ModeでSeparate(PB別
法、設定が楽)かSimultaneous(PB
同時法、測定が速い)を選択します 
 
・Separate(PB別法) 
 Regionsタブで取得したNarrow 
scanのスペクトルを元に、Peak、
Bk1、Bk2の値を設定します 

 Bk1は低エネルギー側バックグラウンド、
Bk2は高エネルギー側バックグラウンドに合
わせます。ここではSiO2由来のSiピークと
metal-Si由来のSiピークに対してPeak,Bk1,Bk2
を設定しています 

・Simultaneous(PB同時法) 
 Channels欄をクリックし、各
Channel(検出器)で取得する強度を
BackgroundにするかPeakにするか
選択します。Range値(全検出器で
測定出来るエネルギー幅)が測定

したい元素の高エネルギー側
Background,Peak,低エネルギー側
Backgroundを抑え込めるように
Pass値を適当に変更します 
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 ステージコントローラーでimage像

を取得したい試料の範囲の、左上
のステージ位置をmemoryNo.1に、

右下のステージ位置を
memoryNo.2に記録させます 

No.1 

No.2 

マッピング
領域 

 ImageタブでReadボタ

ンをクリックし、メモリー
位置を読み込みます。
Scan ではSizeかStepか

選択し、像の解像度を
決定します。Modeでは
Imageを選択します ←マッピング結果の各

元素の画像を色分けし
て重ねる事も出来ます 

左図は赤:Si 青:Auの広域
マッピング結果です 

 Image & Linescan 

 ModeでLinescanを
選ぶとNo.1から
No.2の位置までの
線分析を行います 

Siピーク
(SiO2) 

Siピーク
(metal-Si) 

 ←Simultaneous(PB同
時法)でのLinescan結果 

 Siウェハーの真ん中をAr+
エッチングしたもの 

Si(SiO2) 

Si(metal-Si) 
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 データの基本的な処理 
 測定したスペクトルデータは全
て自動で日付・測定法・線源で名
前が記されてAuto Storageフォル
ダに保存されます 

 File→OpenからAuto Storageフォルダを選

択し、データを選択するとウィンドウ下部に
データの詳細が表示されます 
 

 スペクトルを別の形式で保存す
る場合はFile→Save asでファイル
の種類を選択して下さい 

 テキストファイルとVAMASファイルで出力
出来ます 
 

 File→Reportでスペクトルをレ

ポート形式で画像として出力出来
ます。スペクトルウィンドウ上でコ
ピーをクリックして画像として貼り
付ける事も出来ます 
 データをXPS-PC上で個別に管理

しておきたい場合はデスクトップ
にある「Spec surf測定データ」フォ

ルダ下に研究室単位でまとめて
保存するようにして下さい 

 基本的にデータの管理は各自で行って下
さい。データ保存については保障しません 
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 終了の手続き 

・帯電試料用ホルダーを使用した場合 
電圧・電流値を0にする 
OUTPUT OFF 
POWER OFF 

・中和電子銃を使用した場合 
電圧・電流値を0にする 
Acc.V OFF 
電源 OFF 

・Ar+イオンガンを使用した場合 
オートバルブコントローラー OFF 
3分待つ 
Arガスバルブを時計回りに一回転分閉める 
イオン化室真空計のAVC OFF 

・Angle Resolved測定を行った場合 
ステージを試料交換位置に移動 
X線源の位置を元に戻す(ずらした場合) 
磁場レンズのZ軸をZ=18.45に戻す 
Configurationダイアログのholder設定をStandardに戻す 

・モノクロX線を使用した(Total Reflection測定を行った)場合 
ステージを試料交換位置に移動 
X線源の位置を元に戻す 
分光結晶の窓を閉め(Bakingに合わせる)、ロックネジを締める 
次ページの「X線源を落とす」作業後、15分経過したらMONO/STDボタン
を押してSTDに戻す 

 

まず初めに、下記ケースに応じて終了手順を進めて下さい 
順番を必ず守って下さい 
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 終了の手続き 

・X線を落とす 
Auto/ManuボタンでManualに変更 
X-RAYの電流を最小値に、電圧を最小値にする 
X-RAY電源をOFF 
Displayの表示をFILAMENT POWERに変更 
FILAMENTのADJつまみを回して電流を0にする 
FILAMENT電源をOFF 
SpecSurfのXPS acquisitionのSourceタブでOffをクリック 

・試料の取り出し 
ステージコントローラーのP/MボタンでMEMORY表示に変更 
UP,DOWNボタンでNo.SEを表示させる 
MOVEボタンを押し、試料交換位置へ移動 
V1ボタンを押してV1バルブを開ける 
試料交換棒の黒いリングをOPENの状態にして前方に押し出す 
黒いリングを回してCLOSEにする 
黒いリングを一番後方まで引き、試料を試料交換室に回収 
V1ボタンを再度押してV1バルブを閉める 
試料交換室のロックを開ける 
VENTボタンを押して交換室を大気に開放 
黒いリングを回してOPENにする、ホルダーを回収 
試料交換室のロックして、VENTボタンを押し、真空に引く 

・XPS装置本体の終了 
アナライザー電源 HTをOFF 
X線源を落としてから15分経過後、(モノクロX線利用時、MONO/STDをSTDに切
り替えてから)X-R、SPECボタンをOFF 
冷却器の電源をOFF 
カメラ、カメラモニタ、ステージランプをOFF 

・その他の作業 
研究室USBメモリで測定データを解析用PCに移動 
Spec Surfを終了後、PCシャットダウン、ディスプレイOFF 

ホルダーから試料を回収、ホルダーは洗浄後、真空デシケーターに入れて真
空を引く。作業台を片付ける 
分析室真空度をチェック、終了時間と共に使用記録簿に記入 
他の装置使用者などがいない場合は研究室の照明を落とし、施錠を行う 

全ての測定で共通の手続きです。順番を必ず守って下さい 


